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Einführung 
 

Willkommen zu Rebelle! 

 

Rebelle ist ein einzigartiges Malprogramm, mit welchem Sie realistische nasse und trockene 

Mediengrafiken kreieren können mit verblüffenden Echtzeit-Simulationen von Flüssigkeits-

verläufen, Farbvermischungen, Feuchtigkeitsstreuungen und Trockneneffekten. 

 

Wir haben Rebelle entwickelt für CG Künstler ebenso wie für traditonelle Maler, die ihr 

künstlerisches Repertoire ergründen und erweitern möchten mit modernster und 

bahnbrechender Digital-Maltechnologie. 

 

In diesem Handbuch finden Sie umfassende Informationen, die alle notwendigen Details zur 

problemlosen Nutzung dieser Software umfassen. Wir haben Ihnen hier Features, nützliche 

Hinweise und einige technische Ausführungen zu Rebelle zusammengefasst. 

 

Danke, dass Sie Rebelle erworben haben. Ich hoffe, dass Sie viel Freude beim Malen und 

Kreieren haben! 

 

Peter Blaškovič 

Entwickler von Rebelle 
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Erste Schritte 

Installation und Registrierung von Rebelle 

 

Download & Installieren 

 

Nach Erwerb von Rebelle auf unserer Website erhalten Sie eine E-Mail mit dem Download-

Link und Ihren Registrierungsdetails. 

 

Mac OS X User 

Downloaden Sie die .dmg Datei mit dem Link in der Registrierungs-E-Mail. Lokalisieren Sie 

die Rebelle Installalationsdatei "Rebelle.dmg". Doppelklicken Sie auf den Installer, um die 

Installation auszuführen. 

 

Windows User 

Downloaden Sie die .zip Datei mit dem Link in der Registrierungs-E-Mail. Suchen Sie die 

Rebelle Installalationsdatei "Rebelle.zip". Extrahieren Sie den .zip-Ordner und doppelklicken 

Sie auf den .exe-Installer, um die Installation auszuführen. 

 

 

Registrieren 

 

Füllen Sie Ihre Registrierungsdetails gemäß Ihrer Registrierungs-E-Mail aus. Bitte überprüfen 

Sie, dass Sie mit dem Internet verbunden sind. Die Internetverbindung ist für die Aktivierung 

erforderlich, um Ihre Registrierungsdetails zu prüfen. 

 

 

TIPP: Wir empfehlen, Ihren Registrierungsschlüssel und ID per Copy & Paste einzufügen, um 

Rechtschreibfehler zu vermeiden und vice versa. 

 

 

Der erste Programmstart 

 

Beim ersten Start oder Programmupdates auf eine neuere Version sehen Sie ein Einfüh-

rungstutorial. Dieses Tutorial wird Sie durch die wichtigsten Rebelle Funktionen leiten. Sie 

können das Einführungstutorial auch jederzeit vom Menü -> Help -> Intro Tutorial aus 

starten. 
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Systemanforderungen 

 

Minimum: Intel i3 oder äquivalent AMD, 4GB RAM, 50MB Festplattenspeicher, Open GL 

Grafikkarte mit 1GB RAM, Windows XP, Vista, oder OS X 10.7 - mit dieser Konfiguration kann 

die Aquarell-Wasserfarben-Simulation langsamer funktionieren, ein schnellerer Prozessor 

und größerer Speicher sind besser. 

 

Empfohlen: Intel i7 oder äquivalent AMD, 16GB RAM, 50MB Festplattenspeicher, Open GL 

Grafikkarte mit 2GB RAM, Windows 7, 8 oder OS X 10.9, 10.10, Wacom Tablett. 

 

 

Support für Rebelle 

 

Wenn Sie Hilfe bei der Verwendung von Rebelle benötigen, ziehen Sie bitte das enthaltene 

Hilfemanual zu Rate. Wir haben versucht, es einfach zu halten und alle erforderlichen 

Informationen zu umfassen. 

 

Gerne können Sie uns eine E-Mail senden an support@escapemotions.com bei Fragen, 

technischen Problemen oder wenn Sie uns grüssen möchten. 

 

Bevor Sie eine Frage stellen, lesen Sie bitte die FAQ auf unserer Website 

rebelle.escapemotions.com. Finden Sie dort keine Antwort, fügen Sie bitte Ihre 

Computerkonfiguration Ihrer E-Mail bei (Windows / Mac OS, 32/64bit OS, Prozessor, 

Grafikkarte, Speicher). Dies hilft uns, Antworten schneller zu finden. 

 

 

Community 

 

Bleiben Sie mit uns in Verbindung über unsere Social Channels - klicken Sie auf unten 

stehende Icons und besuchen Sie unsere Seiten auf Facebook, Twitter, Pinterest, Google+, 

Tumblr, YouTube, DeviantArt und Behance. 

 

 
 

  

mailto:support@escapemotions.com
https://www.facebook.com/flamepainterpage?ref=hl
https://twitter.com/escapemotions
http://www.pinterest.com/escapemotions/
https://plus.google.com/u/1/b/109066869359827919028/109066869359827919028/posts
file:///C:/Users/Ada/Dropbox/Escape Motions/!_Rebelle/Manual/tumblr.com/blog/escapemotions
https://www.youtube.com/user/EscapeMotions
http://escmot.deviantart.com/
https://www.behance.net/escapemotions
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Rebelle Interface / Benutzeroberfläche 
 

 
 

 

1 - Menu Bar / Menüleiste 

2 - Navigator Panel / Navigationsfenster 

3 - Tools Panel / Werkzeugleiste 

4 - Tool Properties Panel depending on tool selected / Werkzeugeigenschaften je nach 

      ausgewähltem Werkzeug 

5 - Palette Panel / Farben-Fenste 

6 - Layers Panel / Ebenen-Fenster 

7 - Canvas / Leinwand 

 

Dies ist die standardmässige Rebelle Programmoberfläche, die Sie nach Ihren Bedürfnissen 

anpassen können. 

 

TIPP: Navigator-, Werkzeuge-, Farben- und Ebenen-Fenster sind andockbar - Sie können 

deren Positionen verschieben und die Größen ändern. 
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Tools Panel / Werkzeuge 

Brushes / Pinsel - Aquarell-Wasserfarben, Acrylfarben, 

Pastellkreiden, Stifte, Tuschewerkzeug (Feder), Filz-

stifte (Marker) und Airbrush. 

Eraser / Radierer - Radierwerkzeug auswählen 

Tools / Werkzeuge - Füllen, Verwischen, Wasser, 

Trocknen, Blasen, Farbwähler, Kippen und 

Transformieren. 

Undo / Redo - Letzten Schritt rückgängig machen oder 

wiederholen. 

 

Die nachstehende Abbildung zeigt das Verhalten der einzelnen Maltechniken. 

 

 
 

  Change Tools Panel Layout - Anklicken, um das Layout des Werkzeugfensters horizontal 

oder vertikal anzuordnen. 

 

 Blend / Vermischen - Werkzeug zum Vermischen von Farben oder Pinselstrichen. 

 Smear / Verwischen - Werkzeug zum Verwischen von Farben oder Pinselstrichen. 

 Water / Wasser - Wählen Sie das Wasser-Werkzeug, um Wasserauftrag an bestimmten 

Stellen zu erhalten. 

 Dry / Trocknen - Wählen Sie das Trocknen-Werkzeug, um Farbaufträge an bestimmten 

Stellen zu trocknen. 
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 Blow / Blasen - Wählen Sie dieses Werkzeug, um nasse Farbaufträge zu verblasen. 

 Pick / Farbwähler - Verwenden Sie den Farbwähler, um eine bestimmte Farbe auf Ihrer 

Leinwand zu wählen. 

 Tilt / Kippen - Neigen Sie den Winkel der Leinwand, um nasse Farbaufträge in eine 

bestimmte Richtung verlaufen zu lassen. 

 Transform / Transformieren - Hier können Sie ausgewählte Ebenen bewegen und deren 

Größe verändern. 

 

 Undo / Rückgängig - Letzten Schritt rückgängig machen. 

 Redo / Wiederholen - Letzte Bildänderung wiederholen. 

 

Watercolor Tool Properties / Aquarell-Wasserfarben-

Werkzeugeigenschaften 

Die Parameter simulieren das standardmäßige Ver-

halten von Aquarell-Wasserfarben. Für andere Effekte 

können Sie diese nach Ihren Bedürfnissen ändern: 

 

Size / Größe - Pinseldurchmesser wählen (1-100). 

Pressure / Druck - Pinseldruck wählen (1-100). Wird ein 

Tablett Stift verwendet, können Sie die Druckempfind-

lichkeit einstellen. 

Loading / Farbmenge - Wählt die im Pinsel 

aufgenommene Farbmenge (1-100). Dies beeinflusst 

die aufzutragene Farbdicke. 

Water / Wasser - Wählt die im Pinsel aufgenommene 

Wassermenge (1-100). Je mehr Wasser, desto 

realistischer wird der zu erreichende Wasserverlauf. 

 

TIPP: Setzen Sie "Water" auf 1, um einen leichten Wasserauftrag zu erhalten; oder wählen Sie 

höhere Werte, um mehr Wasser auf bestimmte Stellen der Leinwand aufzutragen. Man 

benötigt nicht viel Wasser, um einen schönen Aquarell-Wasserfarben-Effekt zu erzielen. 
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Acrylic Tool Properties / Acrylfarben-Werkzeug-

eigenschaften 

Acrylfarben sind ein feuchtes Malmittel, das zumeist 

mit flachen Pinseln aufgetragen wird. Sie können die 

Farbparameter nach Ihren Wünschen ändern: 

 

Size / Größe - Pinseldurchmesser wählen (1-100). 

Pressure / Druck - Pinseldruck wählen (1-100). Be-

einflusst die Farbdicke des Pinselauftrags. 

Loading / Farbmenge - Bestimmt die vom Pinsel 

aufzunehmende Farbmenge (1-100).  

Water / Wasser - Bestimmt die vom Pinsel aufzu-

nehmende Wassermenge (1-100) in der Farbe. 

 

TIPP: Setzen Sie "Pressure" und "Loading" auf niedrige Werte, und Sie erhalten einen 

leichteren Pinselstrich. Setzen Sie beide auf höhere Werte, um einen dickeren Pinselstrich mit 

größerer Farbmenge zu erhalten. 

 

 

Pastel Tool Properties / Pastellkreiden-Werkzeug-

eigenschaften 

Pastellkreiden sind ein trockenes Malmittel in Stift-

form, bestehend aus reinem Farbpigmentpuder und 

einem Bindemittel. Sie können die Parameter nach 

Ihren Bedürfnissen ändern: 

 

Size / Größe - Pastelldurchmesser wählen (1-100). 

Pressure / Druck - Pastelldruck wählen (1-100). Dies 

beeinflusst die Farbdichte des Pastellstrichs. 

 

Pencil Tool Properties / Stifte-Werkzeugeigenschaften 

Farbstifte sind ein Malmittel mit einem dünnen 

Pigmentkern eingefasst in einen zylindrischen 

Holzmantel. Sie können die Parameter Ihren Wünschen 

anpassen: 

 

Size / Größe - Stiftdurchmesser wählen (1-100). 

Pressure / Druck - Stiftdruck wählen (1-100). Dies 

beeinflusst die Farbdichte des Stiftestrichs. 
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Ink Pen Tool Properties / Tusche-Werkzeug-

eigenschaften (Feder) 

Tusche ist eine Flüssigkeit aus Pigmenten oder 

Farbstoffen. Sie können die Parameter nach Ihren 

Bedürfnissen ändern: 

 

Size / Größe - Durchmesser des Tuschestrichs (1-100). 

Pressure / Druck - Stärke des Tuschestrichs (1-100). 

Water / Wasser- Bestimmt den Wassergehalt (1-100) 

der Tusche. 

 

 

 

Marker Tool Properties / Filzstifte-Werkzeug-

eigenschaften 

Filzstifte (Marker) haben eine eigene Tintenquelle, 

und üblicherweise eine Zeichenspitze aus porösen, 

gepressten Fasern, wie z. B. Filz. Sie können die 

Parameter Ihren Wünschen anpassen: 

 

Size / Größe - Filzstift- / Markerdurchmesser setzen 

(1-100). 

Pressure / Druck - Farbdichte des Filzstrichs 

bestimmen (1-100). 

 

Airbrush Tool Properties / Airbrush-Werkzeug-

eigenschaften 

Airbrush ist eine kleine Spritzpistole auf Luftbasis, die 

Malmittel wie Tinte und Farbstoffe versprüht. Sie 

können die Parameter Ihren Bedürfnissen anpassen: 

 

Size / Größe - Durchmesser des Airbrushs setzen  

(1-100). 

Pressure / Druck - Druck des Airbrushs bestimmen  

(1-100). Dies beeinflusst die Sprühdichte des Airbrushs. 
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Eraser Tool Properties / Radierer-Eigenschaften 

Size / Größe - Radiergröße bestimmen. 

Pressure / Druck - Radierdruck wählen. 

Softness / Weichheit- Weichheit auswählen. Ein hoher 

Wert macht den Radierstrich weicher, während ein 

niedriger Wert das Papier beeinflusst und die 

Papierstruktur deutlicher macht. 

 

TIPP: Setzen Sie "Pressure" auf niedrige Werte und 

der Radierer wird die Malerei leicht aufhellen. 

 

 

 

Blend Tool Properties / Vermischen-Eigenschaften 

Dieses Werkzeug vermischt die aufgetragenen Farben 

und Pinstelstriche. 

 

Size / Größe - Größe des Misch-Werkzeugs setzen. 

Pressure / Druck - Druck des Misch-Werkzeugs wählen. 

 

 

 

 

 

 

Smear Tool Properties / Verwischen-Eigenschaften 

Dieses Werkzeug verwischt die feuchten und 

trockenen Bereiche der Malerei. 

 

Size / Größe - Größe des Wischwerkzeugs setzen. 

Pressure / Druck - Druck des Wischwerkzeugs wählen. 

 

 

 

 

 

In jedem der Werkzeugfenster können Sie verschiedene Pinselstrukturen wählen. 

 

Hinweis: Pinselstrukturen sind verfügbar via Menü: "Help" -> "Show Data folder", wo Sie 

beliebige Pinsel in den "Brushes" Ordner einfügen können (Pinselbild muss 512x512 Pixel, 

PNG Format, betragen). 



13 
 

Water Tool Properties / Wasser-Werkzeug-

eigenschaften 

Size / Größe - Größe des Wasser-Werkzeugs 

bestimmen. 

Water / Wasser - Wassermenge wählen. Je mehr 

Wasser gewählt ist, desto nasser wird die Leinwand. 

 

Dry Tool Properties / Trocknen-Werkzeug-

eigenschaften 

Size / Größe - Größe des Trocknen-Werkzeugs wählen. 

Absorbency / Saugfähigkeit- Saugkraft der Leinwand 

wählen. Je höher die Zahl, desto schneller wird das 

Wasser absorbiert. 

 

Blow Tool Properties / Blasen-Werkzeug-

eigenschaften 

Dies Werkzeug verbläst eine nasse Farbe in Richtung 

Ihres Strichs. 

Size / Größe - Größe des Blasen-Werkzeugs wählen.  

 

Pick Color Tool Properties / Farbwähler-Eigenschaften 

  Mix Color / Farbe mischen - "Mix Colors" 

aktivieren oder "X" Taste drücken, um Farbe mit vor-

herigen Farbe zu mischen. Sie können die Misch-

empfindlichkeit (Mix Mode Sensitivity) in den 

Preferences -> Palette -> Mix Mode ändern. 

Beispiele: 

  Layer / Ebene - Farbe wird nur von der aktiven 

Ebene aufgenommen. 

  All Layers / Alle Ebenen - Farbe wird von allen 

Ebenen außer der Hintergrundfarbe selektiert. 

  Canvas / Leinwand - Farbe wird von allen Ebenen 

einschließlich der Papierhintergrundfarbe 

aufgenommen. 

Sample Size / Größe Farbauswahl - Größe der 

durchschnittlichen Farbaufnahme in Pixel. 
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Tilt Tool Properties / Kipp-Werkzeugeigenschaften 

Das Kippwerkzeug beeinflusst die Fließrichtung nasser 

Farbaufträge. Es besteht aus einem Kreis mit einem 

Zeiger, den Sie justieren und rotieren können. Durch 

Klick auf den Zeiger setzen Sie die Richtung und Winkel 

der Leinwand-Neigung. Je länger die Tilt-Linie, desto 

größer ist der Winkel. Sie können die Neigung auch 

direkt von der Leinwand bestimmen. 

 

  Reset / Wiederherstellen - Klicken, um die Neigung 

wieder herzustellen.  

 

Hinweis: Die Geschwindigkeit der verlaufenden Farbe ist 

abhängig vom Neigungswinkel der Leinwand, der 

Wassermenge sowie der Farbmenge der Malerei. 

 

 

Navigator Panel / Navigationsfenster 

 

Nutzen Sie das Navigationsfenster, um schnell die 

Ansicht Ihres Kunstwerkes in einer Miniaturansicht zu 

ändern. Der schwarze Rahmen im Navigationsfenster 

entspricht dem aktuell sichtbaren Bereich im Haupt-

fenster. 

 

   Zoom Out / Auszoomen - Aus dem Bild heraus-

zoomen (bis 5%). 

   Zoom In / Einzoomen - In das Bild hineinzoomen 

(bis 800%). 

Zoom Slider / Schieberegler - Setzen Sie den Zoom 

mit dem Schieberegler (1 - 800%). 

   Reset Zoom / Zoomfaktor zurücksetzen - 

Zoomfaktor überprüfen. Bei Klick auf diesen Button 

wird auf 100% gezoomt. 

   Fit to Screen / An Bildschirm anpassen - Passt 

die Leinwand der Bildschirmgröße an. 
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Palette Panel / Farben-Fenster 

Sie können Ihre Malfarbe im Farbfenster wählen: 

Primary Color / Primäre Farbe - Setzt die primäre (am 

meisten genutzte) Farbe. 

Secondary Color / Sekundäre Farbe - Setzt die 

sekundäre Farbe. 

Sie können zwischen primärer und sekundärer Farbe 

wechseln durch Klicken auf die sekundäre Farbe. 

Color Palette / Farbpalette - Sie können die Malfarbe 

von der Farbpalette wählen oder durch Eingabe der 

exakten numerischen Parameter der gewünschten Farbe. 

 

  Color Palette Switch / Farbpalette wechseln - 

Umschalten zwischen Farbkreis und quadratischer 

Farbpalette. 

 

Sie können zwischen HSL und RGB Farbmodell wechseln 

durch Klicken auf den blau-grauen Button in der unteren 

rechten Ecke des Farbfensters. 

H - Farbton (0 - 359) 

S - Farbsättigung (0 - 255) 

L - Helligkeit (0 - 255) 

oder  

R - Rot (0-255) 

G - Grün (0-255) 

B - Blau (0-255) 

 

Hinweis: RGB ist ein geräteabhängiges Farbmodell - unterschiedliche Geräte / Monitore 

können gegebene RGB Werte unterschiedlich darstellen. 

 

 

Set of last used colors / Satz der zuletzt verwendeten Farben - Sie können Ihre eigenen 

benutzerdefinierten Farben erstellen durch Aufnehmen und Klicken auf die Farbe in der 

Farbpalette. Die zuletzt verwendete Farbe wird zuerst angeordnet. 

Color Set / Farbpalette - Standardsatz von verwendeten Farben. Sie können benutzer-

definierte Farben hinzufügen - diese werden für zukünftige Malprojekte gespeichert, auch 

wenn das Programm geschlossen wird. 
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  Mix Color / Farbe mischen - Wählen Sie den "Mix Color" Button oder drücken Sie die 

"X"-Taste auf Ihrer Tastatur, um die aufgenommene Farbe mit der vorherigen zu mischen. 

Sie können Farben mischen von der Farbauswahl, Farbpalette oder Leinwand. 

Beispiel: Wenn Sie Ihre rote Farbe in einem stärkeren Orange-Ton haben möchten, klicken Sie 

auf das orange Farbfeld oder einen orangen Farbpixel auf der Leinwand - das Spektrum wird 

sich zu einer rot-orangen Färbung verändern. Je mehr Sie auf die orange Farbe klicken, desto 

oranger wird der Farbton. 

 

  Use Color Tracing / Farben nachzeichnen - Falls ausgewählt, wird eine Farbe 
automatisch von der Referenzebene ("Tracing Layer") übernommen. Eine aktive Ebene kann 
als "Tracing Layer" gesetzt werden in Menü -> Layer -> Tracing Layer (ein kleines T erscheint 
in der Ebenenvorschau). Diese Ebene dient als Vorlage für Formen und Farben während des 
Malens. 
 

  Order by Hue / Anordnen nach Farbton - Sortiert Farben gemäß ihres Farbtons. Falls 

deaktiviert, wird die zuletzt hinzugefügte Farbe zuerst angeordnet. 

 

   Hinzufügen und Entfernen von markierten Farben zum Farbset. 

 

System Color Palette / Systemfarbpalette 

 

Nachdem Sie auf die Primärfarbe in der linken oberen Ecke geklickt haben, erscheint ein 
neues Farbwahlfenster mit der Systemfarbpalette. Diese Palette unterscheidet sich bzw. 
verhält sich unterschiedlich in Mac OS und Windows: 
 

 

System Color Palette on Windows 

System Color Palette on Mac OS 
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Für Windows Anwender:  
Sie können jede Farbe auf Ihrem Bildschirm auswählen durch Klick auf den "Pick Screen 

Color" Button. Wenn Sie die Maus über Ihren Bildschirm bewegen, sehen Sie die HSV, RGB 

und HTML Parameter einer Farbe. 

 

Die ‘Custom colors’ Option in der Systemfarbpalette zu verwenden ist nicht notwendig. 

Wenn Sie eine Farbe speichern möchten, empfehlen wir den ‘Add’ Button direkt im 

Farbfenster.  



18 
 

Layers Panel / Ebenen-Fenster 

 

  Show Wet / Nässe zeigen - Zeigt die nassen 

Bereiche der aktuellen Ebene. 

  Wet the Layer / Ebene befeuchten - Befeuchtet 

die aktuelle Ebene. 

  Dry the Layer / Ebene trocknen - Trocknet die 

aktuelle Ebene, die Leinwand ist nicht nass. 

  Fast Dry / Schnelltrocknen - Trocknet die aktuelle 

Ebene, das Wasser wird aus der Malerei entfernt, aber 

die Leinwand bleibt feucht. 

 

Hinweis: Wenn Sie die Ebenen wechseln, wird die 

aktuelle Ebene schnellgetrocknet (Wasser wird 

entfernt, aber Leinwand bleibt feucht). Danach wird 

die neue Ebene ausgewählt. 

 

Blending / Fülloptionen - 23 Modi: Normal, Darken, 

Multiply, Color Burn, Linear Burn, Lighten, Screen, 

Color Dodge, Linear Dodge, Overlay, Soft Light, Hard 

Light, Vivid Light, Linear Light, Pin Light, Hard Mix, 

Difference, Exclusion, Subtract, Hue, Saturation, 

Color und Luminosity. 

 

Opacity / Deckkraft - Bestimmt die Deckkraft der Ebene (0-100). 

 

  Lock Layer / Ebene sperren- Sperrt die ausgewählte Ebene oder Ebenen, um sie vor 

unerwünschten Änderungen zu schützen. Die Referenzebene ("Tracing Layer") wird 

standardmäßig gesperrt. 

 

  Eye / Auge - Zeigt oder blendet die Ebene aus (neben dem Ebenen-Icon). 

 

Letter T in a Layers preview / Buchstabe T in einer Ebenenvorschau - Dieser Buchstabe 

markiert eine Referenzebene ("Tracing Layer") - Wählen Sie eine Ebene in der Ebenen-

vorschau und setzen Sie diese als Referenzebene im Menü -> Layer -> Tracing Layer. Diese 

Ebene dient als Mustervorlage für Formen und Farben während des Malens - dies kann ein 

Bild oder Foto sein. 

Paper / Papier - Sie können aus 10 Papiertexturen wählen. Klicken Sie auf das Auge neben 

dem Papier-Icon, um die Papiertextur anzuzeigen oder auszublenden. 
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Sie können die Sichtbarkeit der Papiertextur kontrollieren durch Verwendung des Schiebe-

reglers Texture visibility im Fenster "Select Paper". Hier können Sie auch die Farbe des 

Papiers auswählen. 

Mehr Informationen zu Papiertexturen finden Sie im Kapitel Art Papers (Kunstpapiere). 

 

  Clear Layer / Ebene leeren- Ebeneninhalt leeren (Shortcut Del/Entf). 

  New Layer /Neue Ebene - Neue Ebene hinzufügen. 

  Duplicate Layer / Ebene duplizieren - Dupliziert eine oder mehrere ausgewählte 

Ebenen. 

  Merge Layers / Ebene reduzieren - Verbindet mehrere Ebenen zu einer einzigen Ebene. 

Ist nur eine Ebene ausgewählt, verbindet sich diese automatisch mit der darunterliegenden 

Ebene. 

  Remove Layer / Ebene entfernen - Entfernt eine oder mehrere ausgewählte Ebenen. 

 

Sie können eine Ebene umbenennen durch Doppelklick darauf in der Ebenenliste. 

Sie können die Ebenen durch Drag & Drop in die gewünschte Reihenfolge verschieben. 
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The Menu Bar / Menüleiste 
 

File / Datei - Enthält Elemente im Zusammenhang mit Laden, Speichern, Exportieren und 
Veröffentlichen Ihrer Bilder. 
Edit /Bearbeiten - Enthält Elemente im Zusammenhang mit Editierung des Malprozesses und 
der Leinwand. 
Layer / Ebenen - Enthält Elemente im Zusammenhang mit den Ebenen. 
View / Ansicht - Enthält Elemente im Zusammenhang mit dem Ansichtsfenster. 
Window / Fenster - Enthält Elemente im Zusammenhang mit der Benutzeroberfläche. 
Help / Hilfe - Enthält Elemente für die Anwendungshilfe und Programmupdates auf der 

Webseite. 

 

File Menu / Datei-Menü 

Das Dateimenü enthält Elemente in Bezug auf Ihr Gemälde. Die Funktionen sind wie folgt: 
 
New... / Neu… - Öffnet Dialog zum Erzeugen eines neuen Bildes mit neuen Einstellungen. 
Sie können Breite und Höhe des neuen Bildes in Pixel, Zentimeter oder Inches bestimmen, 
die Papierstruktur, deren Sichtbarkeit und Farbe (mehr zu Papieren im Kapitel Art Papers) 
sowie die DPI festlegen: 
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Sie können auch aus einer Vielzahl vorgegebener Papiergrößen auswählen oder Vorgaben 

hinzufügen / entfernen durch Klick auf die   /   Schalflächen. 
 
Nach Klick auf das Papier-Icon öffnet sich ein neues Fenster mit einer Auswahl an 
voreingestellten Kunstpapieren. 
 
Je nach gewählter DPI werden die Bildgrößen automatisch in Zentimeter und  Inches 

berechnet. 

 

Hinweis: Bitte beachten Sie, dass höhere Auflösungen für Ihr Bild die PC Geschwindigkeit 
verlangsamen können, insb. wenn Sie viel Wasser beim Malen verwenden. 
 
Open... / Öffnen… - Öffnet Dialog zum Öffnen eines Bildes von der Festplatte. 
Open Recent / Zuletzt geöffnet - Eine der zuletzt gespeicherten Kunstwerke öffnen. 
Save / Speichern - Speichert das aktuelle Bild. Wurde das Bild noch nicht gespeichert, wird 
nach einem Namen gefragt. 
Save As… / Speichern unter… - Speichert das aktuelle Bild mit neuem Dateinamen in .reb, 
.png, .jpg, .bmp oder .tif Datei Format. 
Iterative Save / Schrittweises Speichern - Speichert fortlaufend nummerierte Versionen 
eines Kunstwerks. Beim erstmaligen iterativem Speichern wird "_1" an den Dateinamen 
angefügt. Bei jedem nachfolgendem Speichern wird die Zahl um 1 erhöht und eine neue 
fortlaufend nummerierte Datei erstellt. 
Import… / Importieren… - Importiert Bilder in .png, .jpg, .bmp und .tif Format als neue 
Ebene. 
 
Preferences… / Voreinstellungen - Setzt General, Werkzeuge, Palette und Tastatur 
Voreinstellungen: 
- General - Startup Screen / Startbildschirm - Öffnet den "New Artwork" Dialog bei 
Programmstart. Aktivieren Sie diese Option , wenn Sie möchten, dass sich der New Artwork 
Dialog bei jedem Programmstart öffnet. 
  - Canvas - Zoom at cursor / Leinwand - Zoom am Cursor. Aktivieren Sie diese 
Option, wenn Sie vom Cursor aus zoomen möchten, nicht von der Mitte der Leinwand. 
  - Jpeg compression / Kompression - Bestimmt die Qualität der jpeg Datei. 
  - Interface / Programmoberfläche skalieren - Verändert die Größe der 
Programmdarstellung (90-200%). 
 
- Tools / Werkzeuge - Aktiviert den zuletzt verwendeten Pinsel, nachdem eine Farbe aus der 
Palette ausgewählt wurde. Wählen Sie diese Option, wenn Sie den zuletzt genutzten Pinsel 
automatisch auswählen möchten nach Farbauswahl im Palettenfenster. 
 
- Palette  - Tracing Color Sample Size / Größe des Farbe-Nachzeichnen-Tools. Wählen 
Sie die durchschnittliche Mustergröße des Farbnachzeichnens (1 Pixel, 3x3 Pixels, 5x5 Pixel). 
  - Mix Mode Sensitivity - Bestimmen Sie die Emfindlichkeit des Farbmischens. 
Die Sensitivität beeinflusst die Anzahl der Schritte zwischen zwei gemischten Farben. Ist die 
Sensitivität niedrig, werden weniger Schritte (Klicks) für gemischte Farben benötigt. Ist die 
Sensitivität hoch, werden mehr Klicks benötigt, um die zweite gemischte Farbe zu erhalten. 
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- Keyboard / Tastatur - Legen Sie eigene Tastaturkürzel (Shortcuts) fest. Klicken Sie auf 
"Reset", um den aktuellen Shortcut zurückzusetzen. Klicken Sie auf "Reset all", um alle 
Shortcuts zurückzusetzen. 
 
Quit / Beenden - Schließt das Programm (nur in Windows). 
 
TIPP: Sie können Bilder auch per Drag & Drop aus anderen Programmen, Dateimanagern 
oder Internetbrowsern direkt in Rebelle ziehen, soweit die Programme dies erlauben. 
 
Mehr Informationen zum Erstellen, Laden und Speichern Ihrer Bilder finden Sie im Kapitel 
Creating, Opening and Saving Paintings weiter unten stehend in diesem Manual.  
 

Edit Menu / Bearbeiten-Menü 

Undo / Rückgängig - Letzten Schritt rückgängig machen. Die maximale Anzahl an Rück-
gängig-Schritten beträgt entweder 30 oder je nach Speichergröße des Computers. 
Redo / Wiederholen - Letzten Schritt wiederholen. 
 

Layer Menu / Ebenen-Menü 

New Layer / Neue Ebene - Neue Ebene hinzufügen. 
Duplicate Layer / Ebene duplizieren - Eine oder mehrere ausgewählte Ebenen duplizieren. 
Merge Layers / Ebenen reduzieren - Ebenen in eine Ebene reduzieren. 
Delete Layer / Ebene löschen - Löscht eine oder mehrere ausgewählte Ebenen. 
 
Show Layer / Ebene anzeigen - Eine individuelle Ebene anzeigen oder verbergen.  

Tracing Layer / Mustervorlage - Setzt eine aktive Ebene 
als Tracing Layer (ein kleines T in der Ebenenvorschau 
erscheint). Diese Ebene dient als Referenzebene für 

Formen und Farben während des Malens - dies kann ein Bild oder Foto sein. 
 
Use Color Tracing / Farben nachzeichnen - Wenn ausgewählt, wird eine Farbe automatisch 
von der Tracing Layer aufgenommen. 
 
Transform Layer / Ebene transformieren - Aktive Ebene verschieben und skalieren. 
Clear Layer / Ebene leeren - Ebeneninhalt leeren. 
 

View Menu / Ansichtsmenü 

Zoom In / Einzoomen - In das Bild reinzoomen (bis 800%).  
Zoom Out / Auszoomen - Aus dem Bild herauszoomen (bis 5%). 
Zoom 100% - Bestimmen Sie den Zoomwert. Klicken Sie auf den Button, um den Zoomwert 
auf 100% zu setzen. 
Fit to Screen / An Bildschirm anpassen - Passt die Leinwand dem Bildschirm an. 
Show Cursor / Cursor anzeigen - Lassen Sie den Mauszeiger anzeigen oder verbergen. 
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Window Menu / Fenster-Menü 

Tools / Werkzeuge - Werkzeugfenster anzeigen oder verbergen. 
Properties / Werkzeugeigenschaften - Eigenschaftenfenster anzeigen oder ausblenden. 
Palette / Farbfenster - Farbfenster anzeigen oder verbergen. 
Navigator - Navigationsfenster anzeigen oder ausblenden. 
Layers / Ebenen - Ebenenfenster anzeigen oder verbergen. 
Show Panels / Alle Werkzeugfenster anzeigen- Alle Werkzeugfenster anzeigen oder 
ausblenden, um eine größere Arbeitsfläche zum Malen zu erhalten. 
 
Stay on Top / Im Vordergrund bleiben - Die Applikation bleibt immer im Vordergrund vor 
anderen Anwendungen. 
Fullscreen / Vollbild - Stellt auf volle Bildschirmgröße um (klicke Esc, um Fullscreen zu 
beenden).  
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Help Menu / Hilfe 

Help / Hilfe - Öffnet dieses Hilfedokument (in Englisch). 
 
Send Feedback... / Feedback senden... - Schicken Sie uns Ihr Feedback - wenn Sie irgend-
welche Probleme oder Ideen haben oder das Programm Ihnen gefällt. Sie können zwischen 
drei Feedback-Arten wählen: 

Bravo - Wenn Sie uns mitteilen wollen, wie cool Rebelle ist? Dann... 
Idea / Idee - Haben Sie Ideen für neue Features, die eine großartige Ergänzung für Rebelle 
wären? Dann… 
Bug / Fehler - Haben Sie Probleme bei der Nutzung von Rebelle festgestellt? Dann… 

 
… tragen Sie Ihre E-Mailadresse ein und schreiben uns eine Nachricht - wir lesen jede 
einzelne.  
 

 
 
Rebelle Website - Link zur Website: rebelle.escapemotions.com 
Intro Tutorial / Einführung - Zeigt das Einführungstutorial, das Sie durch die wichtigsten 
Rebelle Funktionen führt. 
About Rebelle / Über Rebelle - Grundlegende Information zu Rebelle, Copyright und Dank-
sagungen. 
Show Data Folder / Datenordner anzeigen - Zeigt Ordner an, in denen Pinsel, Daten, 
Dokumente und Papiere gespeichert sind. 
 
Check for updates... / Auf Updates prüfen - Dieser Button ist sichtbar, sobald neue Updates 
zur Verfügung stehen. 
 

http://rebelle.escapemotions.com/
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Starting Painting / Der Malbeginn 

Workflow Options / Optionen 

Beginnen Sie ein neues Gemälde mit leerer Leinwand 

1. Klicken Sie File-> New… und ein neues Fenster erscheint.  

2. Bestimmen Sie Breite und Höhe, Papiertextur und DPI des Bildes 

3. Wählen Sie eine Farbe im Palette-Fenster. 

4. Wählen Sie ein Werkzeug, Pinselbreite und andere Parameter im Werkzeugfenster 

und beginnen Sie zu malen. 

 

Beginnen Sie mit einem Foto oder Bildvorlage 

1. Klicken Sie File-> Open… und wählen Sie Ihr Referenzbild. 

2. Klicken Sie Layer-> Add Layer, um eine neue Ebene über das Referenzbild zu legen. 

3. Wählen Sie eine Farbe im Palette-Fenster. 

4. Wählen Sie ein Werkzeug, Pinselbreite und andere Parameter im Werkzeugfenster 

und beginnen Sie zu malen. 

 

Sie können eine Skizze einscannen oder aus anderen Programmen importieren im.png, .jpg, 

.bmp und .tif Format durch Klicken auf Menü -> File -> Import....  

Auch können Sie ein Bild durch Drag & Drop aus anderen Anwendungen oder Internet-

browsern direkt nach Rebelle ziehen als neue Ebene.  

 

Working with Water / Arbeiten mit Wasser 

Wenn Sie mit einem nassen Medium malen (Aquarell-, Acrylfarben und Tusche/Feder), 

können Sie die zu verwendende Wassermenge bestimmen. Je mehr Wasser, desto schneller 

verteilt sich die Farbe auf der Ebene, und feuchte Farbaufträge vermischen sich. 

Nicht nur die Farben können nass sein, mit dem ‘Wet the Layer’ Button    im Ebenen-

fenster (Layers Panel) können Sie die gesamte Ebene befeuchten. Wie die Farben sich ver-

mischen und trocknen, ist abhängig von der Wassermenge und Feuchtigkeit des Papiers 

darunter.  

Um zu erkennen, ob und wo eine Malerei nass ist, klicken Sie auf den ‘Show Wet’ Button . 

Eine helle blaue Farbe zeigt die Nässe von Papier und Farben - je mehr Wasser verwendet 

wurde, desto dunkler wird die blaue Farbe angezeigt. 

 

 

  

Color Layer Show Wet Fast Dry Dry the Layer Wet the Layer 
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Um Ihren Malprozess zu beschleunigen, haben wir zwei Funktionen implementiert: 

Der ‘Dry the layer’    Button trocknet die aktive Ebene komplett mit all ihren Inhalten - 

Malerei, Papier und verwendetes Wasser. 

Sie können den ‘Fast Dry’ Button    verwenden, wenn Sie Wasser von der aktiven Ebene 

entfernen möchten, aber das Papier nass behalten mögen. 

Sie können verschiedene Maltechniken verwenden, um unterschiedliche Effekte zu 

erreichen. Auf dem folgenden Bild können Sie sehen, wie die unterschiedlichen 

Kombinationen miteinander interagieren. Je nasser Papier und Farben sind, desto mehr 

verlaufen die Farben. Trockene Malwerkzeuge (Pastellkreiden, Filzstifte / Marker und 

Airbrush) jedoch verteilen sich nicht auf feuchten Farben, sie verteilen sich je nachdem wie 

nass Ihr Gemälde ist. 

 

 
 

Wenn Sie mehr über Aquarell-/Wasserfarbentechniken lernen möchten, empfehlen wir 

unsere Tutorials auf YouTube. 

 

 

Tracing Option / Nachzeichnen-Option 

Rebelle ermöglicht Ihnen, Gemälde durch Nachzeichnen von Farben aus einem ausgewähl-

ten Bild zu erstellen. Sie können Bilder durch Drag & Drop direkt von anderen Quellen 

einfügen - Ordner, Browser oder Websites - und diese öffnen sich als neue Ebenen in 

Rebelle. Durch die Tracing Option können Sie bestehende Bilder auf eigene Art neu erstellen. 

Wenn Sie Color Tracing verwenden, wird die Farbe je Strich angewendet. Dies bedeutet, dass 

bei jedem Pinselstrich das Farbpigment des ersten Klicks aufgenommen und weiter 

verwendet wird, bis Sie einen neuen Klick ausführen. Rebelle verfolgt nicht alle Farben einer 

Referenzebene während eines einzelnen Strichs. 

https://youtu.be/DxOVcsTjmVU
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Nachzeichnen eines bestehenden oder importierten Bildes: 

1. Klicken Sie auf Menü -> File -> Import..., um den Import-Dialog zu öffnen. Das Bild 

wird als neue Ebene importiert. Sie können Bilder auch per Drag & Drop direkt aus 

Ordnern oder Browsern importieren. 

2. Selektieren Sie diese Ebene durch Klick auf Menü -> Layer -> Tracing Layer. Die Ebene 

wird als Referenz Tracing Layer markiert (ein kleines T erscheint in der 

Ebenenvorschau). Diese Ebene ist die Mustervorlage für Formen und Farben, 

während Sie malen. 

3. Fügen Sie eine neue Ebene hinzu durch Klick auf Menü -> Layer -> Use Color Tracing, 

oder klicken Sie auf den Button "Use Color Tracing" in der Farbpalette. 

4. Nun können Sie Farben Ihrer Bildvorlage in die aktive Ebene übertragen. 

 

Wenn Color Tracing nicht ausgewählt ist, können Sie mit anderen Farben malen. 

Deaktivieren Sie Tracing Layer im Menü -> Layer ->Tracing Layer. 

Die Tracing Layer ist standardmäßig gesperrt, um die Mustervorlage vor unerwünschten 

Änderungen zu schützen. Sie können die Ebene durch Klick auf den "Lock"-Button 

entsperren. 
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Art Papers / Kunstpapiere 

Es stehen 10 Papiertexturen im Ebenenfenster zur Auswahl. Sie können auch die Farbe des 

Papiers im Paper Color Fenster auswählen - Es stehen 15 Farben für jede Papiertextur zur 

Verfügung. Das Papier ist die Hintergrundebene einer Leinwand. 

Falls gewünscht, können Sie die Papierstruktur im Ebenenfenster anzeigen oder ausblenden 

durch Klick auf den ‘Augen’ Button:  . 

 

 
 

Bitte berücksichtigen Sie, dass die Papierstruktur sich auf das Verhalten von Pinseln und 

Werkzeuge während des Malens, Mischens, Radierens oder anderen Tools auswirkt. 

 

Sie können die Sichtbarkeit der Papiertextur durch Verschieben des Texture visibility Reglers 

kontrollieren. 

   - Hinzufügen oder Entfernen von Papierfarben im Paper Color Fenster. 

 

Abschließend klicken Sie OK zum Bestätigen oder Cancel zum Abbruch der Änderungen. 

 

Hinweis: Die Papiertexturen sind zugänglich via Menü "Help" -> "Show Data Folder", wo Sie 

beliebige randlose Papiertexturen in den "Papers" Ordner einfügen können. Das Programm 

muss dann neu gestartet werden, um die neuen Papiere zu laden.  



29 
 

Creating, Opening and Saving Paintings / 

Neues Bild, Öffnen und Speichern von Bildern 

Creating a New Painting / Neues Bild erstellen 

Um ein neues Bild zu erstellen, wählen Sie die New... Option im File Menü, worauf sich ein 
Fenster New Artwork öffnet. In diesem Fenster können Sie die Größe Ihres neuen Gemäldes 
sowie Einstellungen der Leinwand eingeben, auf der Sie malen möchten. Im Bereich "Picture 
Size Info" können Sie die Bildruckinformationen, wie Höhe, Breite und DPI überprüfen. 
 
Durch Klick auf das Paper Icon können Sie Farbe und Textur des Papiers auswählen. 
 
Abschließend klicken Sie auf OK, um ein neues Bild zu kreieren oder Cancel, um 
abzubrechen. 
 
 

Opening a Painting / Bild öffnen 

Um ein Bild zu öffnen, wählen Sie die Open... Option im File Menü. Im sich neu öffnenden 
Fenster können Sie Bilder oder zuvor in Rebelle gespeicherte Werke im .reb, .png, .jpg, .bmp 
und .tif Dateiformat als neues Projekt öffnen. 
 
Abschließend klicken Sie auf OK, um das Bild zu öffnen oder Cancel, um abzubrechen. 
 
Um ein zuletzt gespeichertes Gemälde zu öffnen, wählen Sie die Open Recent Option im File 

Menü. Diese Option lässt Sie eines der zuletzt gespeicherten Kunstwerke in .reb, .png, .jpg, 

.bmp and .tif Dateiformaten auswählen. 

 

 

Saving a Painting / Bild speichern 

Um Ihr Kunstwerk zu speichern, nutzen Sie die Save... Option im File Menü. Das native 
Format ist ein REB Dateiformat, das alle Informationen der Malerei und der Ebenen enthält. 
Verwenden Sie dieses Format, wenn Sie das Malen später fortsetzen möchten. Wir empfeh-
len, Ihre Arbeit regelmäßig zu speichern, insb. wenn Sie sich mit der neuen Software vertraut 
machen. 
 
Wenn Sie Ihr Gemälde mit spezifischen Einstellungen speichern möchten oder in einem 
Format, das mit anderen Anwendungen geöffnet werden kann, wählen Sie die Save As... 
Option im File Menü. Dies erlaubt Ihnen, Ihr Bild als PNG, TIF, BMP oder JPG Datei abzu-
speichern. Sie müssen die Ebenen nicht zusammenführen, um eine Kopie Ihres Gemäldes 
zum Drucken oder zum Veröffentlichen im Internet zu erstellen. 
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Hinweis: Bitte beachten Sie, dass nur REB Dateien alle Artwork Informationen enthalten. 
PNG, TIF und BMP Dateien speichern nur Farb- und Transparenzinformationen. JPG Dateien 
speichern keine Transparenz. 
 
Abschließend klicken Sie auf OK, um das Bild zu speichern oder auf Cancel, um abzubrechen. 
 

Iterative Save / Schrittweises Speichern - Speichert fortlaufend nummerierte Versionen 
eines Kunstwerks. Beim erstmaligen iterativem Speichern wird "_1" an den Dateinamen 
angefügt. Bei jedem nachfolgendem Speichern wird die Zahl um 1 erhöht und eine neue 
fortlaufend nummerierte Datei erstellt. 
 
 

Closing Application / Programm schließen 

Wenn Sie die Anwendung schließen möchten, können Sie je nach Betriebssystem folgende 
Optionen wählen: 
 

Windows user 
- Klick auf File Menü -> Quit, oder  
- Klick auf Close Button im 
Programmfenster rechts oben, oder 
- verwenden Sie den Shortcut Ctrl+W or 
Alt+F4 
 
 

Mac OS user 
- Klick auf das Rebelle Menü-> Quit, oder 
- Klick auf Quit Button im Programm-
fenster links oben, oder 
- verwenden Sie den Shortcut Cmd-Q in 
Mac OS 
 
 

 

Hinweis: Bitte vergessen Sie nicht, Ihr Bild VOR dem Programmschließen zu speichern. 

 

 



Keyboard Shortcuts / Tastaturkürzel 
   gültig für deutsche und österreichische Tastaturen 
 
     Windows   Mac OS 
New... / Neu    Ctrl-N    Cmd-N 
Open... / Öffnen    Ctrl-O    Cmd-O 
Save / Speichern   Ctrl-S    Cmd-S 
Save As... / Speichern unter  Ctrl-Shift-S   Cmd-Shift-S 
Iterative Save / Schrittweises Speichern Ctrl-Alt-S   Cmd-Alt-S 
Import… / Importieren   Ctrl-Shift-O   Cmd-Shift-O 
Preferences / Einstellungen  Ctrl-,    Cmd-, 
Quit / Beenden    Ctrl-W    Cmd-Q 
 
Undo / Rückgängig   Ctrl-Z    Cmd-Z 
Redo / Wiederholen   Ctrl-Shift-Z   Cmd-Shift-Z 
 
Brushes / Pinsel    B    B 
Eraser / Radiergummi   E    E 
Blend / Vermischen   N    N 
Smear / Verwischen   S    S 
Water / Wasser    W    W 
Dry / Trocknen    D    D 
Blow / Blasen     Shift oder O   Shift oder O 
Pick a color / Farbwähler   Alt oder I   Alt oder I 
Tilt / Kippen    L    L 
Transform Layer  / Transformieren T oder Ctrl-T   T oder Cmd-T 
 

Mix / Mischen    X    X 

Show Wet / Nässe zeigen  H    H 

Fast Dry / Schnelltrocknen  F    F 

Paint / Malen    B    B 

 

Increase Brush Size / Pinselspitze vergrößern Alt Gr + ]   ] 

Decrease Brush Size / Pinselspitze verkleinern Alt Gr + [   [ 

Clear Layer Content / Ebene leeren Del / Entf   Del 

 
Increase Value +1 / Wert um 1 vergrößern Up / Auf   Up 
Decrease Value -1 / Wert um 1 verkleinern Down / Abwärts  Down 
Increase Value +10 / Wert um 10 vergrößern Pg Up / Bild aufwärts Pg Up 
Decrease Value -10 / Wert um 10 verkleinern Pg Down / Bild abwärts Pg Down 
 
Move a Canvas / Leinwand verschieben Maus Rechtsklick halten o. Leertaste  + Maus Rechtsklick 
Show | Hide All Panels / Alle Werkzeugfenster anzeigen | ausblenden Tab 
Zoom In / Einzoomen   + / Ctrl - +   + / Cmd - + 
Zoom Out / Auszoomen   - / Ctrl - -   - / Cmd - - 
Zoom 100%    0 / Ctrl - 0   0 / Cmd - 0 
Fit to Screen / An Bildschirm anpassen .    . 
Zoom In | Out / Ein- |Auszoomen Mausrad oder Alt + Mausrad 
Help / Hilfe    F1    Cmd + ? 
 
Hinweis: Sie können eigene Tastaturkürzel festlegen im File Menü -> Preferences -> Keyboard  
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Copyright & Danksagungen 
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User Interface Icons / Benutzeroberfläche Icons: "Batch" by Adam Whitcroft 
 
 

Used Libraries/ Bibliotheken: 
 
Diese Applikation ist mit den folgenden Bibliotheken entwickelt worden: 
 
Qt 5.4, LGPL license - http://qt-project.org/downloads/ 
QuaZIP, LGPL license - http://sourceforge.net/projects/quazip/ 
CryptoPP, Boost Software license - http://www.cryptopp.com/ 
ImageMagick, Apache license - http://www.imagemagick.org/ 
AntiGrain Geometry 2.4, LGPL license - http://agg.sourceforge.net/antigrain.com/index.html 
MB WebSockets, LGPL license - https://qt.gitorious.org/qtplayground/mbwebsockets 
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http://www.imagemagick.org/
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https://qt.gitorious.org/qtplayground/mbwebsockets
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Rebelle End-User Software License Agreement 
 
 
Copyright 2015 Escape Motions, s.r.o. All Rights Reserved. 
 
This license is a legal agreement between you and Escape Motions for the use of Rebelle 
software (the "Software"). By downloading, installing, copying, or otherwise using the 
Software, you acknowledge that you have read terms and conditions of this license, 
understand them, and agree to be bound by them. If you do not agree with these terms and 
conditions, Escape Motions is unwilling to license the Software to you, and you are not 
authorized and may not use the Software. 
 
 
Permitted Use 
 
Users of the Rebelle may use the Software for commercial, or for-profit activities as well as 
for personal, non-commercial, or non-profit activities. 
The Software may be installed on a computer that is for multiple users but it may not be 
installed on more than one computer regardless of whether those computers are operated 
simultaneously or not. 
You may install the Software on multiple computers provided that not more than one of 
those computers is in use simultaneously and that those computers are solely for your own 
personal use. 
 
You may not remove the copyrights notices from the Software. You may make one (1) copy 
of the Software for back-up or archival purposes. 
 
 
Restrictions 
 
This is a SINGLE COPY SOFTWARE LICENSE. The Software is copyrighted and protected by law 
and international treaty. This is a license, not a transfer of title, and unless you have been 
granted prior, written consent from Escape Motions you may not: 
a, Reproduce, distribute, or transfer the Software, or portions thereof, to any third party. 
b, Sell, rent, lease, assign, or sublet the Software or portions thereof. 
c, Grant rights to any other person. 
d, Modify, decompile, reverse engineer, disassemble, or create derivative works based on 
the Software or the documentation in whole or in part. 
e, Use the Software in violation of any international law or regulation. 
 
You must not intentionally or unintentionally make the Software available on any web 
server, ftp server, file sharing network, shared directory, or other location where any other 
person can acquire a copy of the Software. You are responsible for keeping the Software 
safe from being copied by others. 
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Display of Copyright Notices 
 
All copyright and proprietary notices and logos within the Software files must remain intact. 
 
 
Indemnity 
 
You agree to indemnify and hold harmless Escape Motions for any third-party claims, actions 
or suits, as well as any related expenses, liabilities, damages, settlements or fees arising from 
your use or misuse of the Software, or a violation of any terms of this license. 
 
The Software may contain technical inaccuracies or typographical errors, so changes and/or 
updates may be affected without notice. 
Peter Blaskovic may also make improvements and/or other changes to the Software at any 
time without notice. 
 
 
Disclaimer Of Warranty 
 
THE SOFTWARE IS PROVIDED \"AS IS\", WITHOUT WARRANTY OF ANY KIND, EXPRESSED OR 
IMPLIED, AS TO THE SOFTWARE OR ITS OPERATION, INCLUDING, BUT NOT LIMITED TO, 
WARRANTIES OF QUALITY, PERFORMANCE, NON-INFRINGEMENT, MERCHANTABILITY, OR 
FITNESS FOR A PARTICULAR PURPOSE. FURTHER, PETER BLASKOVIC DOES NOT WARRANT 
THAT THE SOFTWARE OR ANY RELATED SERVICE WILL ALWAYS BE AVAILABLE. 
 
 
Limitations Of Liability 
 
YOU ASSUME ALL RISK ASSOCIATED WITH THE INSTALLATION AND USE OF THE SOFTWARE. 
IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS OF THE SOFTWARE BE LIABLE 
FOR CLAIMS, DAMAGES OR OTHER LIABILITY ARISING FROM, OUT OF, OR IN CONNECTION 
WITH THE SOFTWARE. LICENSE HOLDERS ARE SOLELY RESPONSIBLE FOR DETERMINING THE 
APPROPRIATENESS OF USE AND ASSUME ALL RISKS ASSOCIATED WITH ITS USE, INCLUDING 
BUT NOT LIMITED TO THE RISKS OF PROGRAM ERRORS, DAMAGE TO EQUIPMENT, ANY LOST 
PROFITS, BUSINESS INTERRUPTION, LOSS OF DATA OR SOFTWARE PROGRAMS, OR 
UNAVAILABILITY OR INTERRUPTION OF OPERATIONS. 
 


